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Warranty
Tektronix warrants that this product will be free from defects in materials and workmanship for a period of three (3) years from the date of
shipment. If any such product proves defective during this warranty period, Tektronix, at its option, either will repair the defective product
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Customer if the shipment is to a location within the country in which the Tektronix service center is located. Customer shall be responsible
for paying all shipping charges, duties, taxes, and any other charges for products returned to any other locations.

This warranty shall not apply to any defect, failure or damage caused by improper use or improper or inadequate maintenance and care.
Tektronix shall not be obligated to furnish service under this warranty a) to repair damage resulting from attempts by personnel other than
Tektronix representatives to install, repair or service the product; b) to repair damage resulting from improper use or connection to
incompatible equipment; c) to repair any damage or malfunction caused by the use of non-Tektronix supplies; or d) to service a product
that has been modified or integrated with other products when the effect of such modification or integration increases the time or difficulty
of servicing the product.

THIS WARRANTY IS GIVEN BY TEKTRONIX WITH RESPECT TO THE PRODUCT IN LIEU OF ANY OTHER WARRANTIES, EXPRESS
OR IMPLIED. TEKTRONIX AND ITS VENDORS DISCLAIM ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE. TEKTRONIX' RESPONSIBILITY TO REPAIR OR REPLACE DEFECTIVE PRODUCTS IS THE SOLE AND
EXCLUSIVE REMEDY PROVIDED TO THE CUSTOMER FOR BREACH OF THIS WARRANTY. TEKTRONIX AND ITS VENDORS WILL
NOT BE LIABLE FOR ANY INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES IRRESPECTIVE OF WHETHER
TEKTRONIX OR THE VENDOR HAS ADVANCE NOTICE OF THE POSSIBILITY OF SUCH DAMAGES.
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Important safety information
Safety information provides warnings and cautions that help you operate the instrument safely and keep the instrument in a safe
working condition.

This manual contains information and warnings that must be followed by the user for safe operation and to keep the product in a
safe condition.

To safely perform service on this product, see the Service safety summary that follows the General safety summary.

General safety summary
Use the product only as specified. Review the following safety precautions to avoid injury and prevent damage to this product or
any products connected to it. Carefully read all instructions. Retain these instructions for future reference.

Comply with local and national safety codes.

For correct and safe operation of the product, it is essential that you follow generally accepted safety procedures in addition to
the safety precautions specified in this manual.

The product is designed to be used by trained personnel only.

Only qualified personnel who are aware of the hazards involved should remove the cover for repair, maintenance, or adjustment.

Before use, always check the product with a known source to be sure it is operating correctly.

This product is not intended for detection of hazardous voltages.

Use personal protective equipment to prevent shock and arc blast injury where hazardous live conductors are exposed.

While using this product, you may need to access other parts of a larger system. Read the safety sections of the other
component manuals for warnings and cautions related to operating the system.

When incorporating this equipment into a system, the safety of that system is the responsibility of the assembler of the system.

To avoid fire or personal injury
Use proper power cord. Use only the power cord specified for this product and certified for the country of use. Do not use the
provided power cord for other products.

Ground the product. This product is grounded through the grounding conductor of the power cord. To avoid electric shock, the
grounding conductor must be connected to earth ground. Before making connections to the input or output terminals of the
product, ensure that the product is properly grounded. Do not disable the power cord grounding connection.

Power disconnect. The power cord disconnects the product from the power source. See instructions for the location. Do not
position the equipment so that it is difficult to operate the power cord; it must remain accessible to the user at all times to allow for
quick disconnection if needed.

Connect and disconnect properly. Do not connect or disconnect probes or test leads while they are connected to a voltage
source. Use only insulated voltage probes, test leads, and adapters supplied with the product, or indicated by Tektronix to be
suitable for the product.

Observe all terminal ratings. To avoid fire or shock hazard, observe all rating and markings on the product. Consult the product
manual for further ratings information before making connections to the product. Do not exceed the Measurement Category
(CAT) rating and voltage or current rating of the lowest rated individual component of a product, probe, or accessory. Use caution
when using 1:1 test leads because the probe tip voltage is directly transmitted to the product.

Do not apply a potential to any terminal, including the common terminal, that exceeds the maximum rating of that terminal.

Do not float the common terminal above the rated voltage for that terminal.
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Do not operate without covers. Do not operate this product with covers or panels removed, or with the case open. Hazardous
voltage exposure is possible.

Avoid exposed circuitry. Do not touch exposed connections and components when power is present.

Do not operate with suspected failures. If you suspect that there is damage to this product, have it inspected by qualified
service personnel.

Disable the product if it is damaged. Do not use the product if it is damaged or operates incorrectly. If in doubt about safety of the
product, turn it off and disconnect the power cord. Clearly mark the product to prevent its further operation.

Before use, inspect voltage probes, test leads, and accessories for mechanical damage and replace when damaged. Do not use
probes or test leads if they are damaged, if there is exposed metal, or if a wear indicator shows.

Examine the exterior of the product before you use it. Look for cracks or missing pieces.

Use only specified replacement parts.

Use proper fuse. Use only the fuse type and rating specified for this product.

Wear eye protection. Wear eye protection if exposure to high-intensity rays or laser radiation exists.

Do not operate in wet/damp conditions. Be aware that condensation may occur if a unit is moved from a cold to a warm
environment.

Do not operate in an explosive atmosphere.

Keep product surfaces clean and dry. Remove the input signals before you clean the product.

Provide proper ventilation. Refer to the manual's installation instructions for details on installing the product so it has proper
ventilation.

Slots and openings are provided for ventilation and should never be covered or otherwise obstructed. Do not push objects into
any of the openings.

Provide a safe working environment. Always place the product in a location convenient for viewing the display and indicators.

Avoid improper or prolonged use of keyboards, pointers, and button pads. Improper or prolonged keyboard or pointer use may
result in serious injury.

Be sure your work area meets applicable ergonomic standards. Consult with an ergonomics professional to avoid stress injuries.

Use care when lifting and carrying the product. This product is provided with a handle for lifting and carrying.

Use only the Tektronix rackmount hardware specified for this product.

Probes and test leads
Before connecting probes or test leads, connect the power cord from the power connector to a properly grounded power outlet.

Keep fingers behind the finger guards on the probes.

Remove all probes, test leads and accessories that are not in use.

Use only correct Measurement Category (CAT), voltage, temperature, altitude, and amperage rated probes, test leads, and
adapters for any measurement.

Important safety information  
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Beware of high voltages. Understand the voltage ratings for the probe you are using and do not exceed those ratings. Two
ratings are important to know and understand:

■ The maximum measurement voltage from the probe tip to the probe reference lead.

■ The maximum floating voltage from the probe reference lead to earth ground.

These two voltage ratings depend on the probe and your application. Refer to the Specifications section of the manual for more
information.

WARNING. To prevent electrical shock, do not exceed the maximum measurement or maximum floating voltage for the
oscilloscope input BNC connector, probe tip, or probe reference lead.

Connect and disconnect properly. Connect the probe output to the measurement product before connecting the probe to the
circuit under test. Connect the probe reference lead to the circuit under test before connecting the probe input. Disconnect the
probe input and the probe reference lead from the circuit under test before disconnecting the probe from the measurement
product.

Connect and disconnect properly. De-energize the circuit under test before connecting or disconnecting the current probe.

Connect the probe reference lead to earth ground only.

Do not connect a current probe to any wire that carries voltages above the current probe voltage rating.

Inspect the probe and accessories. Before each use, inspect probe and accessories for damage (cuts, tears, or defects in the
probe body, accessories, or cable jacket). Do not use if damaged.

Service safety summary
The Service safety summary section contains additional information required to safely perform service on the product. Only
qualified personnel should perform service procedures. Read this Service safety summary and the General safety summary
before performing any service procedures.

To avoid electric shock. Do not touch exposed connections.

Do not service alone. Do not perform internal service or adjustments of this product unless another person capable of rendering
first aid and resuscitation is present.

Disconnect power. To avoid electric shock, switch off the product power and disconnect the power cord from the mains power
before removing any covers or panels, or opening the case for servicing.

Use care when servicing with power on. Dangerous voltages or currents may exist in this product. Disconnect power, remove
battery (if applicable), and disconnect test leads before removing protective panels, soldering, or replacing components.

Verify safety after repair. Always recheck ground continuity and mains dielectric strength after performing a repair.

 Important safety information
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Terms in the manual
These terms may appear in this manual:

WARNING. Warning statements identify conditions or practices that could result in injury or loss of life.

CAUTION. Caution statements identify conditions or practices that could result in damage to this product or other property.

Terms on the product
These terms may appear on the product:

■ DANGER indicates an injury hazard immediately accessible as you read the marking.

■ WARNING indicates an injury hazard not immediately accessible as you read the marking.

■ CAUTION indicates a hazard to property including the product.

Symbols on the product

When this symbol is marked on the product, be sure to consult the manual to find out the nature of the potential
hazards and any actions which have to be taken to avoid them. (This symbol may also be used to refer the user to
ratings in the manual.)

The following symbols may appear on the product:
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Preface
This manual provides product safety and compliance, how to connect and power on the oscilloscope, and an introduction to the
instrument features, controls and basic operations. See the product Help file for more detailed information.

Key features
Welcome to the 5 Series Mixed Signal Oscilloscope. The 5 Series MSO Oscilloscopes (MSO54, MSO56, and MSO58) are 4-, 6-,
and 8-channel oscilloscopes with the world's first FlexChannel™-based inputs, enabling you to efficiently and cost-effectively
perform mixed signal debugging on virtually any design.

■ Bandwidths from 350 MHz to 2 GHz

■ 4-, 6-, and 8-channel models with FlexChannel inputs

■ Each FlexChannel input supports one analog channel or eight digital channels, in any combination

■ FlexChannel inputs are compatible with TekVPI® probes

■ Large 15.6” HD (1920 x 1080 pixel) capacitive touch-screen display

■ User interface designed to optimize touch screen use and quickly access key settings

■ Stacked mode places each channel or waveform in its own horizontal 'slice' on the screen, allowing for cleaner signal
viewing and measuring

■ Maximum 6.25 GS/s sample rate

■ 62.5 M points record length on all channels (optional 125 M record length available)

■ 500,000 waveforms/second maximum waveform capture rate

■ No set limit on the number of math, reference, and bus waveforms you can display  1

■ Integrated optional features include a 50 MHz arbitrary function generator (AFG), and a DVM and trigger frequency counter

■ Optional advanced triggering features let you trigger and take measurements on industry serial bus data standards including
I2C, SPI, USB 2.0, CAN, LIN, FlexRay, RS-232/422/485/UART, Audio (I2S, LJ, RJ, TDM), and Ethernet

Related documents
Use the related documents to access information on how to remotely program or operate the instrument, understand theory of
operation, replace suspected modules, and do other tasks.

To learn about Use this document
How to use instrument
functions

5 Series Mixed Signal Oscilloscope MSO54, MSO56, MSO58 Help (Tektronix part number
077-1303-xx; Printable version of the instrument Help; available at www.tektronix.com/
downloads)

How to remotely control the
instrument

5 Series Mixed Signal Oscilloscope MSO54, MSO56, MSO58 Programmer Manual (Tektronix
part number 077-1305-xx; available at www.tektronix.com/downloads)

Instrument specifications and
procedures to verify the
instrument meets
specifications

5 Series Mixed Signal Oscilloscope MSO54, MSO56, MSO58 Specifications and Performance
Verification Technical Reference (Tektronix part number 077-1306-xx; available at
www.tektronix.com/downloads)

1 Actual number of waveforms depends on available system memory.
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To learn about Use this document
Instrument theory of operation,
troubleshooting, disassembly,
and replaceable parts

5 Series Mixed Signal Oscilloscope MSO54, MSO56, MSO58 Service Manual (Tektronix part
number 077-1307-xx; available at www.tektronix.com/downloads)

Installing the instrument in a
rack

RM5MSO Rack Mount Kit Instructions (Tektronix part number 071-3523-xx; available at
www.tektronix.com/downloads)

Using the TLP058 Logic Probe TLP058 FlexChannel Logic Probe Instructions (Tektronix part number 071-3515-xx; available at
www.tektronix.com/downloads)

Preface  
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Installing your instrument

Check shipped accessories
Make sure that you received everything you ordered. If anything is missing, contact Tektronix Customer Support. In North
America, call 1-800-833-9200. Worldwide, visit www.tek.com to find contacts in your area.

Check the packing list that came with your instrument to verify that you have received all ordered items. Check that you received
all standard accessories.

Item Quantity Tektronix part number
5 Series Mixed Signal Oscilloscope (MSO54, MSO56, MSO58) Installation
and Safety Manual

1 071-3514-xx

TPP0500B Passive Voltage Probe (500 MHz bandwidth). Shipped with
350 MHz and 500 MHz models.

One per channel TPP0500B

TPP1000 Passive Voltage Probe (1 GHz bandwidth). Shipped with 1 GHz
and 2 GHz models.

One per channel TPP1000

Front cover 1 200-5406-xx
Accessory pouch (attached to front cover) 1 016-2106-xx
Mouse (wired with USB connector) 1 119-7054-xx
Power cord 1 Depends on region
Calibration certificate 1 N/A

If you purchased factory installed options such as Advanced Serial Triggering, tap Help > About to confirm that the option(s) are
listed in the Installed Options table.

Safely rotate the handle
Use the correct process to eliminate the chance of pinching your thumb or rear-panel-connected cables while rotating the handle.

CAUTION. Hold the top of the handle to rotate the handle on the instrument. Do not hold the handle from the sides and rotate, as
this can pinch the base of your thumb between the handle and the case.

If you have routed any cables between the handle and the case, be careful when rotating the handle so that you do not pinch the
cables.
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Operating requirements
Use the oscilloscope within the required operating temperature, power, altitude, and signal input voltage ranges to provide the
most-accurate measurements and safe instrument operation.

Environment requirements

Characteristic Description
Operating temperature 0 °C to +50 °C (+32 °F to +122 °F)

For proper cooling, keep the sides and rear of the instrument clear of obstructions for
2 inches (51 mm).

Operating humidity 5% to 90% relative humidity (% RH) up to +40 °C (+104 °F)
5% to 55% RH above +40 °C up to +50 °C (+104 °F to +122 °F), Noncondensing.

Operating altitude Up to 3000 meters (9842 feet)

Power requirements

Characteristic Description
Power source voltage 100 V - 240 VAC RMS, ±10%, single phase
Power source frequency 50/60 Hz, 100-240 V (90-264 V)

400 Hz, 115 V (103-127 V)
Power consumption All models: 400 W maximum

Installing your instrument  
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Input signal requirements
Keep the input signals within allowed limits to ensure the most accurate measurements and prevent damage to the analog and
digital probes or instrument.

Make sure that input signals are within the following requirements.

Input Description
Analog input channels, 1 M Ω setting, maximum input voltage
at BNC

300 VRMS
Measurement Category II

Analog input channels, 50 Ω setting, maximum input voltage at
BNC

5 VRMS

Digital input channels, maximum input voltage range at digital
inputs

Observe probe ratings
TLP058; ±42 VP

Ref In maximum input voltage at BNC (rear panel) 7 VPP

Secure (lock) the oscilloscope
Lock an oscilloscope to a test bench or equipment rack to prevent property loss.

Attach a standard laptop security lock to the rear panel of the oscilloscope, to secure the oscilloscope to a workbench, rack, or
other location.
 

 

 Installing your instrument
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Powering the oscilloscope
Use this procedure to connect the oscilloscope to line power and power on and off the oscilloscope. Always connect the
oscilloscope to AC power using the power cord that shipped with the instrument.

Prerequisite: Use the AC power cord that shipped with your oscilloscope.

1. Connect the supplied power cord to the oscilloscope power connector.
 

 

2. Connect the power cord to an appropriate AC mains source.
Power is supplied to the power supply and some other boards whenever the AC power cord is connected to a live mains
circuit, putting the instrument in standby mode.

3. Push the front panel power button to power the instrument on and off.
The power button indicates instrument power states:

No light – no AC power applied

Yellow – standby mode

Blue – powered on

4. To completely remove power from the instrument, disconnect the power cord.

5. To transport the instrument with its power cord, flip out the power cord supports on the upper edge of the rear panel and
wrap the power cord around the supports.

Installing your instrument  
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Check that oscilloscope passes power-on self tests
Power-on self tests verify that all oscilloscope modules are working correctly after power up.

1. Power on the oscilloscope and wait until the oscilloscope screen appears.

2. Select Utility > Self Test from the top-edge Menu bar to open the Self Test configuration menu.

3. Check that the power-on self tests are Passed.

If the power-on self test shows Failed:

a. Power cycle the oscilloscope.

b. Tap Utility > Self Test. If the power-on self test still shows Failed, contact Tektronix Customer Support.

Connecting Probes
Probes and cables connect the oscilloscope to your device under test (DUT). Use a probe that best matches your signal
measurement needs.
 

 

Connect TPP0500, TPP1000, TekVPI+®, TekVPI®, or other supported Tektronix analog probes by pushing them into a
FlexChannel connector. The probe base latch locks with a 'click' when the probe is fully seated.

TekVPI probes automatically set the channel input parameters for that probe (bandwidth, attenuation, termination, and so on). If
a probe has a Menu button, push that button to open an on-screen configuration menu. Follow instructions provided with active
probes to set their parameters (auto zero, degauss, and so on).

To connect a TLP058 FlexChannel Logic Probe:

1. Move the locking lever to the unlocked position, then let go to reset locking lever to the center position.

2. Insert the probe into a FlexChannel channel until fully seated and the lock mechanism clicks.

3. Move the locking lever to the locked position. The status light should be a solid green.

4. To disconnect the TLP058 probe, move and hold the locking lever at the unlocked position and pull out the probe. Do not
pull on the ribbon cable while removing the probe.

Connect a BNC probe or cable by pushing it onto a channel BNC bayonet connector and turn the lock mechanism clockwise until
it locks.

 Installing your instrument
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Connecting a probe does not automatically display or enable that channel. Tap an Inactive Channel button to turn on that
channel. Double-tap the Channel badge to open its configuration menu to verify or change probe or cable settings (bandwidth,
attenuation, termination and so on).

Rackmount information
The optional RM5 Rackmount Kit lets you install the oscilloscope in standard equipment racks. The rackmount requires seven
rack units (7U) of space to install.

RM5 Rackmount Kit (Option RM5).

1. Purchase or obtain the rackmount kit.

2. Follow the instructions that came with the rackmount kit (RM5 Rackmount Kit Instructions, Tektronix part number 071-3523-
xx).

3. Make sure to allow adequate clearance on the sides and rear for air ventilation, and on the back for any cables you attach to
the rear panel.

Installing your instrument  
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Getting acquainted with your instrument
The following content provides a high-level description of the instrument controls and user interface.

Refer to the 5 Series Mixed Signal Oscilloscope MSO54, MSO56, MSO58 Help on the instrument for detailed information on
using the controls and user interface to display waveforms and take measurements.

Front panel controls and connectors
The front panel controls provide direct access to key instrument settings such as vertical, horizontal, trigger, cursors, and zoom.
The connectors are where you input signals with probes or cables, or insert USB devices.
 

 

 

1. Acquisition and Cursors controls:
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■ Run/Stop starts and stops waveform acquisition. The button color indicates the acquisition status (green = running and
acquiring; red = stopped). When stopped, the oscilloscope shows waveforms from the last completed acquisition. The
Run/Stop button on the screen also shows the acquisition status.

■ Cursors button turns screen cursors on or off. Use the Multipurpose knobs to move the cursors. Double-tap the cursor
readouts, or on a cursor bar (line), to open the configuration menu to set cursor types and functionality. See Display
and configure cursors on page 47.

■ Fast Acq™ enables or disables the fast acquisition mode. FastAcq provides high-speed waveform capture that
reduces the dead time between waveform acquisitions, enabling the capture and display of transient events such as
glitches and runt pulses. It is helpful in finding elusive signal anomalies. Fast acquisition mode can also display
waveform phenomena at an intensity that reflects their rate of occurrence.

■ Single/Seq enables making a single waveform acquisition, or a specified number of acquisitions (as set in the
Acquisition configuration menu). Pushing Single/Seq turns off Run/Stop mode and takes a single acquisition. The
button color indicates the acquisition status (quick green flash = single acquisition acquired; solid green = waiting for
trigger event). Pushing Single/Seq again takes another single acquisition.

■ High Res applies unique finite impulse response (FIR) filters based on the current sample rate. This FIR filter
maintains the maximum bandwidth possible for that sample rate while rejecting aliasing. The filter removes noise from
the oscilloscope amplifiers and ADC above the usable bandwidth for the selected sample rate. Implementation of the
filter in hardware, ahead of the trigger and storage, reduces trigger jitter and enables using Fast Acq mode while in
High Res mode.

High Res mode also guarantees at least 12 bits of vertical resolution. The number of bits of resolution is displayed in
the Acquisition badge at the bottom of the screen. The Horizontal badge also updates to show the sample rate and
record length settings while in High Res mode.

■ Clear deletes the current acquisitions and measurement values from memory.

2. Multipurpose knobs:
 

 

■ Multipurpose knobs (A, B) The Multipurpose knobs A and B move cursors and set parameter values in configuration
menu input boxes. Selecting an input box that can use a Multipurpose knob assigns the indicated knob to change the
value in that input box. The ring around each knob lights when you can use that knob to do an action.
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Push a Multipurpose knob to enable the Fine mode for making smaller increment changes. Push the knob again to exit
Fine mode.

3. Trigger controls:
 

 

■ Force forces a trigger event at a random point in the waveform and captures the acquisition.
■ Level sets the amplitude level that the signal must pass through to be considered a valid transition. The color of the

Level knob indicates the trigger source except for dual-level triggers. The Level knob is disabled when the trigger type
requires two level settings or other trigger qualifiers (set from the Trigger configuration menu). Push the knob to set the
threshold level to 50% of the peak-to-peak amplitude range of the signal.

■ Slope sets the signal transition direction to detect (low to high, high to low, or either direction). Push the button to cycle
through the selections. The Slope button is disabled when the trigger type requires other slope qualifiers (set from the
Trigger configuration menu).

■ Mode sets how the instrument behaves in the absence or presence of a trigger event.
■ Auto trigger mode enables the instrument to acquire and display a waveform whether or not a trigger event occurs. If a

trigger event occurs, the instrument displays a stable waveform. If a trigger event does not occur, the instrument forces
a trigger event and acquisition and displays an unstable waveform.

Normal trigger mode sets the instrument to acquire and display a waveform only when there is a valid trigger event. If
no trigger occurs, the last waveform record acquired remains on the display. If no last waveform exists, no waveform is
displayed.
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4. Vertical controls:
 

 

■ Position moves the selected waveform (Channel, Math, Reference, Bus) and its graticule up or down on the screen.
The color of the Position knob indicates which waveform the knob is controlling. Push the knob to set the threshold
level to 50% of the peak-to-peak amplitude range of the signal.

■ Scale sets the amplitude units per vertical graticule division of the selected waveform. The scale values are shown on
the right edge of the horizontal graticule lines, and are specific to the selected waveform in both Stacked or Overlay
modes (in other words, each waveform has its own unique vertical graticule settings regardless of display mode). The
color of the Scale knob indicates which waveform the knob is controlling.

■ Channel buttons (1-4 for MSO54, 1-6 for MSO56, 1-8 for MSO58) turns on (displays), selects, or turns off a channel,
as follows:

■ If the channel is not displayed, pushing a Channel button turns on that channel to the Waveform view.
■ If the channel is on the screen and is not selected, pushing that channel's button selects that channel.
■ If the channel is on the screen and is also selected, pushing that channel's button turns that channel off (removes

it from Waveform view).
■ The Math button adds or selects a Math waveform on the Waveform view, as follows:

■ If no Math waveform exists, pushing the Math button adds a Math waveform to the Waveform view and opens the
Math configuration menu.

■ If only one Math waveform is displayed, pushing the button turns off the Math waveform (removes it from
Waveform view). Push the button again to display the waveform.

■ If two or more Math waveforms are displayed, pushing the button cycles through selecting each math waveform.
■ The Ref button adds or selects a Reference (saved) waveform on the Waveform view, as follows:

■ If no Reference waveform exists, pushing the Ref button opens the Browse Waveform Files configuration menu.
Navigate to and select a waveform file (*.wfm) and tap Recall to load and display the reference waveform.

■ If only one Reference waveform is displayed, pushing the button turns off the Reference waveform (removes it
from the Waveform View). Push the button again to display the waveform.

■ If two or more Reference waveforms are displayed, pushing the button cycles through selecting each Reference
waveform.

■ The Bus button adds or selects a bus waveform on the Waveform view, as follows:

■ If no Bus waveform exists, pushing the Bus button adds a Bus waveform to the Waveform view and opens the
Bus configuration menu.

■ If only one Bus waveform is displayed, pushing the button turns off the Bus waveform (removes it from Waveform
view).

■ If two or more Bus waveforms are displayed, pushing the button cycles through selecting each Bus waveform.
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5. Horizontal controls:
 

 

■ Position moves the waveform and graticule side to side on the screen (changing the trigger point position in the
waveform record). Push the knob to center the trigger event to the center graticule on the Waveform view.

■ Scale sets the time per major horizontal graticule division and samples/second parameters for the oscilloscope. Scale
applies to all waveforms. Push the knob to enable the Fine mode for making smaller increment changes. Push the
knob again to exit Fine mode.

■ Zoom opens the Zoom mode. Push Zoom again to exit zoom mode. See The Zoom user interface elements on
page 26.

■ Zoom knob (ce9nter knob) increases or decreases the area of the zoom box in the Zoom Waveform Overview, which
in turn controls the zoom amount of the waveforms shown in the main Zoom view.

■ Pan knob (outer knob) moves the Zoom box left or right in the Zoom Waveform Overview, which in turn controls the
part of the waveform shown in the main Zoom view.

■ Navigate (left and right arrow) buttons puts the oscilloscope in Zoom mode and positions the previous or next search
point in the waveform record to the center graticule of the Waveform view. There must be a Search badge present in
the Results bar before the Navigate function will operate. See Badges on page 19.

The front panel Navigate buttons can also be used for the Previous and Next button functions on measurement
badges.
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6. Miscellaneous controls:
 

 

■ Touch Off turns touch screen capability off. The Touch Off button is lighted when the touch screen is turned off.
■ User is a one-push save operation that uses the current menu bar File > Save As settings to save screen shots

(including open menus and dialog boxes), waveform files, instrument settings, and so on, as follows:

■ If a File > Save or File > Save As operation has occurred since the last instrument startup, pushing User saves
the file types to the location last set in the Save As configuration menu.

■ If no file save operation has occurred since the last instrument startup, pushing User opens the Save As
configuration menu. Select a tab to select what type of file to save (Screen Capture, Waveform, and so on), set
any associated parameters, and where to save it, and select OK. The specified file or files are saved. The next
time you push User, the specified files are saved.

■ Screen Captures capture the entire screen, including most displayed configuration menus and dialog boxes.
■ Default Setup restores the oscilloscope settings (horizontal, vertical, scale, position, and so on) to the factory default

settings.
■ Autoset automatically displays a stable waveform. See Quickly display a waveform (Autoset) on page 35.

7. Ground and Probe Compensation connectors:
 

 

■ The Ground and Probe Compensation connectors are located at the lower right side of the instrument, near the front
panel. The Ground connector (the small hole in the case) provides an electrically grounded (through a resistor)
connection point to attach an anti-static wrist strap, to reduce electrostatic damage (ESD) while you handle or probe
the DUT.

■ The Probe Compensation connections provide a ground connector (upper tab) and 1 kHz square wave source (lower
tab) for adjusting the high-frequency response of a passive probe (probe compensation). The oscilloscope uses this
signal to automatically compensate supported probes, including the ones that ship with the product. See Compensate
the TPP0500B or TPP1000 probes on page 30.
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8. USB Host ports (USB 3.0 and 2.0):
 

 

■ USB ports are located at the lower right corner of the front panel, and on the rear panel. Connect USB flash drives to
which you can save or recall data (such as instrument software updates, waveforms, settings, and screen captures), or
connect peripheral devices such as a mouse or keyboard.

9. FlexChannel probe connectors:
 

 

■ FlexChannel connectors support all TekVPI+ and TekVPI measurement probes, BNC passive probes, the TPL058
FlexChannel Logic Probe, and BNC cables. You connect most probes simply by pushing them into the connector until
the probe seats with a click. See Connecting Probes on page 5.
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Rear panel connections
The rear panel connections supply power to the oscilloscope and provide connectors for network, USB devices, video, reference
signals, and the AFG output.
 

 

1. Power cord connector. Use only the power cord specified for this product and certified for the country of use.

2. Ref In lets you connect a high-precision 10 MHz reference signal to the oscilloscope for more accurate measurements.

3. AUX Out generates a signal transition on a trigger event, outputs a 10 MHz reference signal, or outputs a synchronization
signal from the AFG.

4. AFG Out is the signal output for the Arbitrary Function Generator (AFG).

5. Video outputs (Display Port, VGA, and DVI-D) let you connect an external monitor or projector to show the oscilloscope
screen.

6. USB Device port lets you connect to a PC to remotely control the oscilloscope using USBTMC protocol.

7. USB Host ports let you connect a USB memory device, keyboard, or mouse.

8. LAN connector (RJ-45) connects the oscilloscope to a 10/100/1000 Base-T local area network.

9. Security lock connector lets you use a standard PC/laptop lock cable to secure the oscilloscope to a work bench or other
location.
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The user interface screen
The touch screen user interface contains waveforms and plots, measurement readouts, and touch-based controls to access all
oscilloscope functions.

1. The Menu bar provides menus for typical operations including:

■ Saving, loading, and accessing files
■ Undoing or redoing an action
■ Setting oscilloscope display and measurement preferences
■ Configuring network access
■ Running self tests
■ Erasing measurement and settings memory (TekSecure™)
■ Loading option licenses
■ Opening a Help viewer.

2. The Waveform View area displays analog, digital, math, reference, bus, and trend waveforms. The waveforms include
waveform handles (identifiers), individual vertical graticule scale labels, and trigger position and level(s) indicators. You can
set the Waveform View to stack each waveform vertically in separate graticules, called 'slices' (the default mode, as shown
in the previous image), or overlay all the waveforms on the screen (traditional waveform view). See The user interface
elements on page 16.

You can also add Histogram, Spectral, Eye, and Measurement Results views (plots) for individual measurements. These
plot views are separate view windows that you can move on the screen by dragging their title bar to a new position.
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3. The Results Bar contains controls for displaying cursors, adding notes, plots, and result tables to the screen, and add
measurements to the Results bar. The controls are:

■ The Cursors button displays on-screen cursors in the selected view. Touch and drag, or use the Multipurpose knobs,
to move the cursors. Double-tap on a cursor, or on the cursor readouts, to open a configuration menu to set cursor
types and related functions.

■ The Measure button opens a configuration menu from which to select and add measurements to the Results bar. Each
measurement you add has a separate badge. Double-tap a measurement badge to open its configuration menu.

■ The Results Table button adds a Measurement or Bus Results table to the screen. The Measurement Results table
displays all measurements present in the Results bar. The Bus Results table displays bus decode information for
displayed bus waveforms. Each table is contained within its own view window, which can be moved within the display
area.

■ The Note button adds a note object to the selected view. Double-tap the note text to open a configuration menu to
change the text and font characteristics. Drag the note to any location on the view. Notes cannot be added to a
Results Table view.

■ The Search button lets you detect and mark a waveform where specified events occur. Tap Search to open a Search
configuration menu and set the search conditions for analog and digital channels. You can add any number of
searches to the same waveform or to different waveforms. Search badges are added to the Results bar.

■ The Plot button adds an XY, XYZ, or Eye Diagram plot to the display. These plots are contained within their own
window and can be moved within the overall display area.

■ The Measurement and Search badges show measurement and search results. and are displayed in the middle area
of the Results bar. See Badges on page 19. See Add a measurement on page 40. See Add a Search on
page 45.

■ The Draw-a-Box button at the bottom of the Results Bar lets you draw a box on the screen to zoom in on an area of
interest.

■ The Trash Can icon lets you drag Channel, Waveform, Measurement, and Search badges to the Trash Can to delete
them.

4. The Settings Bar displays System badges for setting Horizontal, Trigger, Acquisition, and Date/Time parameters; Inactive
Channel buttons to turn on channels; Add New Waveform buttons to add math, reference, and bus waveforms to the
display; and Channel and Waveform badges that let you configure the individual waveform parameters. Tap a channel or
waveform button to add it to the screen and display a badge. Double-tap any type badge to open its configuration menu.
See Badges on page 19.

5. Configuration Menus let you quickly change the parameters of the selected user interface item. You can open
configuration menus by double-tapping on badges, screen objects, or screen areas. See Configuration menus on page 24.

The user interface elements
Each area of the user interface has a specific function that helps manage information or controls. This topic shows and describes
the key user interface elements.
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1. The Waveform Record View is a graphical high-level view of the overall waveform record length, how much of the record is
on the screen (shown in brackets), the location of key time events including the trigger event, and the current position of
waveforms cursors.
 

 

If you are displaying a reference waveform that is shorter than the current acquisition record length, or you are changing the
horizontal time scale while the oscilloscope acquisition is stopped, the brackets change position to show the part of the
waveform record that is being viewed relative to the current acquisition record length.
 

 

If cursors are active on a waveform, the Waveform record view shows the relative cursor positions as small vertical dashed
lines.
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When in Zoom mode, the Waveform Record View is replaced with the Zoom Overview. See The Zoom user interface
elements on page 26.

2. The Expansion Point icon on the waveform view shows the center point around which the waveform expands and
compresses when changing horizontal settings.
 

 

3. The Trigger Position Indicator shows where the trigger event occurred in the waveform record. The trigger icon is
displayed in the waveform slice that is the trigger source.
 

 

4. The Zoom icon (in upper right corner of Waveform and Plot views) toggles zoom on and off. The front panel Zoom button
and knobs also turn on zoom mode and change the position and horizontal size of the Zoom Box.
 

 

5. The Trigger Level Indicator icon(s) shows the trigger level on the trigger source waveform. Some trigger types require two
trigger levels.

6. Measurement and Search badges show measurement and search results. See Badges on page 19. See Add a
measurement on page 40.

7. The Results Bar Handle opens or closes the Results Bar, to maximize waveform screen viewing when needed. To reopen
the Results bar, either tap the handle icon or swipe left from the right side of the display.

8. The System badges show global instrument settings (Horizontal, Trigger, Acquisition, Run/Stop status, and Date/Time).
See Badges on page 19.

9. The Inactive Channel buttons add channel waveforms to the Waveform view and add an associated Channel badge to the
Settings bar.

The Add New buttons add Math, Reference, and Bus waveforms to the Waveform view, and add an associated Waveform
badge to the Settings bar. You can add any number of Math, Reference, and Bus waveforms, limited only by system
memory.

The optional AFG button opens the AFG configuration menu to set and enable the AFG output. This button is only present if
the AFG option is installed.

The optional DVM button lets you use an analog probe to take DC, AC RMS, or DC+AC RMS voltage measurements on
your DUT. Tap the button to add a DVM badge to the Results Bar and open a configuration menu. The DVM option also
enables a trigger frequency counter, accessible from the Mode & Holdoff panel in the Trigger badge menu. This button is
only present if the DVM option is installed.

10. Channel and Waveform badges (Math, Reference, Bus) show active channel and waveform settings and their status
(selected, unselected, inactive). Double-tap a badge to open its associated configuration menu. See Badges on page 19.
See Configuration menus on page 24.
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If you add more Channel or Waveform badges than can fit in the waveform badge area, use the scroll buttons at each end
of the waveform badge area to let you scroll through all badges.

11. The Waveform Handles identify the channel or source waveform (C1-C8 for channels, Mx for Math waveforms, Rx for
Reference waveforms, Bx for bus waveforms). The waveform handles are at the zero-volt level of the waveform. The
currently selected waveform handle is a solid color; unselected waveform handles are outlined.

Double-tapping a waveform handle opens the configuration menu for that waveform.

For digital channels, the waveform handle shows the channel number, with the individual digital signal handles marked D0–
D7. The colors follow a color code similar to that used on resistors. The D0 indicator is white, the D1 indicator is brown, the
D2 indicator is red, and so on.
 

 

Double-tapping a digital waveform handle opens the digital channel configuration menu.
Dragging a digital signal handle over another handle swaps those two signals on the waveform.

Badges
Badges are rectangular icons that show waveform, measurement, and instrument settings or readouts. Badges also provide fast
access to configuration menus. The badge types are Channel, Waveform, Measurement, Search, and System.

Channel and Waveform badges
Channel and Waveform badges are located in the Settings Bar, located along the bottom left of the screen. These badges show
settings for each displayed channel or waveform. Each waveform (channel, math, reference, bus, and trend) has its own badge.
Double-tap a badge to open its configuration menu.
 

 

Most Channel and Waveform badges also have Scale buttons, shown by single-tapping the badge. Use the Scale buttons to
increase or decrease the vertical scale setting for that waveform.
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Channel badges are listed in the channel order. You cannot move Channel badges other than to drag them into the Trash Can
icon to turn them off.

Waveform badges (Math, Ref, Bus, Trend) are listed in the order created, and are grouped together by type. Deleting a
Waveform badge does not change the order or names of the remaining badges. You cannot move Waveform badges other than
to drag them to the Trash Can icon to delete them.

Measurement badges
Measurement badges are located in the Results Bar. They show measurements or search results. The badge title also shows
the measurement source or sources. To add a Measurement badge, tap the Add New Measurement button and select a
measurement. Double-tap a Measurement badge to open its configuration menu to change or refine settings. The default
measurement badge readout shows the measurement's mean (μ) value.
 

 

To add statistical readouts to individual measurement badges, double-tap a measurement badge to open its configuration menu
and select Show Statistics in Badge.
 

 

Some Measurement badges also have Navigation buttons, shown by single-tapping the badge.
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The < (Previous) and > (Next) buttons center the waveform in the display at the position of the previous or next measurement
point in the record (for measurements that take more than one measurement per acquisition).

The Min' and Max' navigation buttons center the waveform in the display at the minimum or maximum value for that
measurement in the current acquisition.

The prime symbol (') shown on measurement readings and Min/Max buttons indicates that the value shown (or moved to in the
case of Min/Max and waveforms) is from the current acquisition. Lack of a prime symbol means the value is from all acquisitions.

Measurement badges are listed in the order created, starting at the top of the Results bar. Deleting a Measurement badge does
not change the order or names of the remaining badges. You cannot move Measurement badges other than to drag them into
the Trash Can icon to delete them.

Search badges
Search badges are also located in the Results Bar, below the Measurement badges. A search badge defines the search source,
type, and the number of search criteria events (occurrences) in the current acquisition, and marks the waveform where those
events occur with small down-pointing triangles along the top of the waveform graticule. Double-tap a search badge to open its
configuration menu to change or refine search settings.
 

 

Search badges are created by tapping the Add New... Search button. Use the displayed configuration menu to set the search
criteria.

Search badges have < (Previous) and > (Next) Navigation buttons that open the Zoom mode and center the waveform in the
display at the position of the previous or next search mark in the waveform record. Search badge Navigation buttons are only
usable when the oscilloscope is in single acquisition mode. Single-tap a badge to close the Navigation buttons.
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Some searches also provide Min and Max navigation buttons that open the Zoom mode and center the waveform in the display
at the minimum or maximum value for that search event in the current acquisition.

Search badges are listed in the order created. Deleting a Search badge does not change the order or names of the remaining
badges. You cannot move Search badges other than to drag them into the Trash Can icon to delete them.

Signal Clipping and Badges

WARNING. Clipping is caused by excessive or dangerous voltage at the probe tip, and/or a vertical scale setting that is not
adequate to display the entire vertical range of the waveform. Excessive voltage at the probe tip can injure the operator and
cause damage to the probe and/or instrument.

This instrument shows a warning triangle symbol and the words Clipping in a Channel badge when a vertical clipping condition
exists. Any measurement badges associated with that channel also indicate a clipping condition by turning the measurement text
red and listing the type of clipping (positive or negative).
 

 

To close the clipping message, change the vertical scale to show the entire waveform, disconnect the probe tip from the
excessive voltage source, and check that you are probing the correct signal using the correct probe.

Clipping causes inaccurate amplitude-related measurement results. Clipping also causes inaccurate amplitude values in saved
waveform files. If a math waveform is clipped, it will not affect amplitude measurements on that math waveform.

System badges
System badges (in the Settings bar) display the main Horizontal, Trigger, and Acquisition settings. You cannot delete System
badges.
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Double-tap a System badge to open its configuration menu.

The Horizontal badge also has Scale buttons, shown by single-tapping the badge. Use the Horizontal Scale buttons to increase
or decrease the horizontal time setting.

Common badge actions

Action Result Example
Single tap Immediate access controls (Scale,

Navigation).

Double tap Configuration menu with access to
all settings for the badge.

Touch and hold Right-click menu with single tap
access to common actions. Typical
actions include turning off a
channel and deleting a
measurement or search badge.
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Badge selection status
The appearance of a badge indicates its selection status (selected or unselected), or if a measurement needs to be deleted to
close a channel or waveform badge.

Badge type Selected Unselected Turned off or in use  1

Channel or
Waveform

Measurement N/A

Configuration menus
Configuration menus let you quickly set the parameters for channels, system settings (Horizontal, Trigger, Acquisition),
measurements, cursor readouts, Waveform and Plot views, note text, and so on.

Double-tap an item (badge, Waveform or Plot view, cursor readouts, note text, and so on) to open its configuration menu. For
example, double-tap a Channel badge in the Settings bar to open its configuration menu.
 

1 A dimmed Channel badge means the screen waveform is turned off (but not deleted). A dimmed Waveform badge means that the waveform display is turned off, or it is
being used as a source by a measurement and cannot be deleted until the measurement is deleted.
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Selections or values that you enter take effect immediately. Menu contents are dynamic, and can change depending on your
selections.

Related settings are grouped into 'panels.' Tap the panel name to show those settings. Changes to panel settings can change
the values and/or fields shown in that panel and other panels.
 

 

Tap anywhere outside a configuration menu to close it.
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To open Help content for a configuration menu, tap the question mark Help icon in the upper right corner of the menu.

The Zoom user interface elements
Use the zoom tools to magnify waveforms to view signal details.
 

 

1. The Zoom Overview shows the entire waveform record. All waveforms are shown in Overlay mode in the Zoom Overview
area.

NOTE. Using pinch and expand gestures on the Zoom Overview waveforms changes the horizontal time base settings.

2. The Zoom Box shows the area of the Zoom Overview to display in the Zoom View. You can touch and drag the box to
move the area to view. You can also use the zoom Pan knob to move the Zoom Box left or right.

NOTE. Moving the Zoom Box, or changing its position, does not change the horizontal time base settings.

3. The Zoom icon (in the upper right corner of the Waveform View) switches zoom mode on and off.

4. The Draw-a-Box button lets you quickly draw a box around an area of interest in the Waveform or Zoom Overview on which
to zoom. Drawing a box immediately puts the oscilloscope into zoom mode. The button is located at the bottom of the
Results bar. Tap the button, then touch and drag on the waveform to draw a box on the area of interest.

To keep the Draw-a-Box button enabled, double-tap the Draw-a-Box button. Keeping the Draw-a-Box function enabled lets
you update your Zoom display by drawing new boxes in either the Waveform Slice or Zoom Overview window.

5. The Zoom View shows the zoomed waveforms as marked by the Zoom Box in the Zoom Waveform Record View. Use
pinch and/or drag options in the zoom view to change the zoomed area of interest.

NOTE. Pinch, expand, and drag gestures in the Zoom View only change zoom magnification settings and Zoom Box
position.

6. Use the Zoom Title Bar controls to adjust the vertical and horizontal size of the zoom area. Click or tap the + or - buttons.
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Using the touch screen interface for common tasks
Use standard touch screen actions, similar to those found on smart phones and tablets, to interact with most screen objects. You
can also use a mouse to interact with the UI. The equivalent mouse operation is shown for each touch operation.

The oscilloscope has a user interface tutorial. Tap Help > User Interface Tutorial to quickly learn the fundamental touch
operations.

 

Table 1: Common touchscreen UI tasks (with mouse equivalents)

Task Touchscreen UI action Mouse action
Add a channel, math, reference, or bus
waveform to the screen.

Tap an inactive channel button, Add New
Math, Add New Reference, or Add New
Bus button.

Click an inactive channel button, Add
New Math, Add New Reference, or Add
New Bus button.

Select a channel, math, reference, or bus
waveform to make it active

Stacked or Overlay mode: Tap the
Channel or Waveform badge.
Stacked mode: Tap the channel, math,
reference, or bus waveform slice or
handle.
Overlay mode: Tap the channel or
waveform handle.

Stacked or Overlay mode: Left-click the
Channel or Waveform badge.
Stacked mode: Left-click the channel,
math, reference, or bus waveform slice or
handle.
Overlay mode: Left-click the channel or
waveform handle.

Display scale or navigation buttons on a
badge (waveform, measurement  1,
search, horizontal).

Tap the badge. Click the badge.

Open a configuration menu on any item
(all badges, views, cursor readouts,
labels, and so on).

Double-tap the badge, view, or other
object.

Double-click the badge, view, or other
object.

Open a right-click menu (badges, views). Touch and hold on the badge, Waveform
View, Plot view, or other screen item until
a menu opens.

Right-click the object.

Close a configuration menu  2. Tap anywhere outside the menu or
dialog.

Click anywhere outside the menu or
dialog.

Move a menu. Touch and hold the menu title bar or a
blank area in the menu, then drag the
menu to new position.

Click and hold the right mouse button on
title or blank area, drag to new position.

Move a note  3. Touch and hold on a note and quickly  4

start to drag, then move to new position.
Click and hold the right mouse button on
the note and quickly start to drag, then
move to the new position.

1 Not all measurement or search badges display navigation buttons.
2 Some dialog boxes will not close until you click an OK, Close, or other button in the dialog.
3 Notes are screen objects and are not associated with any particular waveform channel or slice.
4 Start to move the note as soon as selected (highlighted), otherwise the UI opens the right-click menu.
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Task Touchscreen UI action Mouse action
Change horizontal or vertical settings
directly on a waveform.
Vertical changes only apply to the
selected channel or waveform; horizontal
changes apply to all channels and
waveforms.

Tap a badge and use the Scale buttons.
Pinch or expand two fingertips on the
waveform view, move them together or
apart vertically or horizontally, lift from
screen; repeat.

Left-click a channel, waveform, or
Horizontal badge and click on the Scale
buttons.

Increase or decrease the zoom area
(while in Zoom mode)

Pinch or expand two fingertips on the
waveform view, move them together or
apart vertically or horizontally, lift from
screen; repeat.

Click the + or - buttons on the Zoom Title
bar.
Click the Draw-a-Box button, draw a box
around the waveform area of interest.

Quickly scroll or pan a waveform or list. Touch and drag in the waveform or list. Click and drag in the waveform or list.
Close or open the Results Bar to increase
the Waveform view area.

Tap on the Results Bar Handle (three
vertical dots) or anywhere in the divider
between the Waveform View and the
Results Bar.

Click the Results Bar Handle (three
vertical dots) or anywhere in the divider
between the Waveform View and the
Results Bar.
Click and drag the Results Bar divider.
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Configure the instrument

Set the time zone and clock readout format
Set the time zone to your region so that saved files are marked with the correct date and time information. You can also set the
time format (12 or 24 hour clock).

1. Double-tap the Date/Time badge (bottom-right of screen) to open the configuration menu.
 

 

2. Select your local time zone and the time format (12 or 24 hour). Settings take place immediately.

3. To turn off showing the date and time on the screen, tap the Display button to Off.
To turn on date/time display again, double-tap in the blank area where the date/time badge was displayed to open the
configuration menu, and set the Display button to On.

4. Tap anywhere outside of the menu to close it.

Download and install the latest firmware
Loading the latest firmware helps ensure that your oscilloscope is taking the most accurate measurements. You can check for
the latest updates from network-connected oscilloscopes, or download the update file to a USB drive and install from there.

Prerequisite: Save any important on-instrument files (waveforms, screen captures, oscilloscope setups, and so on) to a USB
drive or network.

Update oscilloscope firmware from USB drive
Prerequisite: Determine the current version of firmware installed on the oscilloscope (Help > About)

1. Open up a Web browser on a PC and go to www.tektronix.com/software.

2. Enter MSO5 in the search field and click Search.

3. Select Software in the Filter by type list.

4. If the listed available firmware version is newer than what is on your oscilloscope, select and download that file to your PC.

5. Follow the installation instructions that came with the downloaded firmware to create a firmware install file.

6. Copy the firmware install file to a USB drive.

7. Insert the USB drive into any oscilloscope USB Host port. The oscilloscope detects the USB drive with the firmware file and
starts the installation process.
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8. Follow instructions to install the firmware.

NOTE. Do not power off the oscilloscope or remove the USB flash drive until the oscilloscope finishes installing the
firmware. The oscilloscope displays a message when it is OK to turn off the oscilloscope.

9. When the firmware install is finished, remove the USB drive and restart the oscilloscope.

To confirm the firmware installation:

1. Tap Help > About in the Menu bar.

2. Verify that the firmware version number listed on the screen is the same version that you downloaded.

Run Signal Path Compensation (SPC)
Run SPC at regular intervals for best measurement accuracy. You should run SPC whenever the ambient (room) temperature
has changed by more than 5 °C (41 °F), or once a week if you use vertical scale settings of 5 mV per division or less.

Signal Path Compensation (SPC) corrects for DC level inaccuracies in the internal signal path, caused by temperature variations
and/or long-term signal path drift. Failure to run SPC on a regular basis may result in the oscilloscope not meeting warranted
performance levels at low volts per division settings.

Prerequisite: Disconnect all probes and cables from the front-panel channel inputs and rear-panel signal connectors.

1. Power on and warm up the oscilloscope for at least 20 minutes.

2. Tap Utility > Calibration.

3. Tap Run SPC. The SPC Status readout shows Running while SPC is running. SPC can take several minutes per channel
to run, so wait until the SPC Status message changes to Pass before reconnecting probes and using the oscilloscope.

CAUTION. You can abort the SPC calibration by tapping Abort SPC. This may leave some channels uncompensated,
resulting in possible inaccurate measurements. If you do abort the SPC, make sure to run the SPC procedure completely
before using the instrument to take measurements.

4. Close the Calibration configuration dialog when SPC has completed.

5. If the SPC fails, write down any error message text. Make sure that all probes and cables are disconnected and run the SPC
again. If the SPC still fails, contact Tektronix Customer Support.

Compensate the TPP0500B or TPP1000 probes
Probe compensation adjusts the high frequency response of a probe for best waveform capture and measurement accuracy. The
oscilloscope can automatically test and store compensation values for an unlimited number of probe/channel combinations.

The oscilloscope stores the compensation values for each probe/channel combination, and automatically recalls the
compensation values when you plug in the probe. Probe compensation status is shown in the Probe Setup panel of the Channel
configuration menu.

■ If the Probe Compensation Status field displays Pass, the probe is compensated and ready for use.

■ If the Probe Compensation Status field displays Default, the attached probe has not been compensated and needs to have
this probe compensation procedure run.
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■ If the Probe Compensation Status field displays Fail, the attached probe has failed the probe compensation procedure.
Reconnect the probe and run probe compensation again.

■ If there is no probe compensation status field shown in the panel, the oscilloscope cannot store compensation values for
that probe. See the oscilloscope Help for how to manually compensate passive probes not supported by the probe
compensation function.

Use this procedure to compensate a TPP0500B, TPP1000, or other supported TPP-family probe that shows a Default status
when connected to the oscilloscope.

NOTE. A Default Setup does not delete probe compensation values. A factory calibration deletes all stored probe compensation
values.

Prerequisite: The oscilloscope must be powered on for at least 20 minutes before compensating a probe.

1. Connect a supported probe to an input channel. The probes shipped with the oscilloscope support this probe compensation
process.

2. Connect the probe tip and ground lead of the probe to the PROBE COMP terminals on the lower right side of the
oscilloscope (near the Default Setup and Autoset front panel buttons).
 

 

Connect the probe tip to the 1 kHz source (lower connector), and the ground clip to the ground (upper connector). For best
results, remove any probe tip accessories and hold the probe tip directly onto the 1 kHz connector.

NOTE. Connect only one probe at a time to the PROBE COMP terminals.

3. Turn off all channels.

4. Turn on the channel to which the probe is connected.

5. Push the front-panel Autoset button. The screen displays a square wave.

6. Double-tap the badge of the channel you want to compensate.

7. Tap the Probe Setup panel.

If the Probe Compensation Status says Pass, the probe is already compensated for this channel. You can move the probe
to another channel and start again from step 1, or connect a different probe to this channel and start from step 1.

If the Probe Compensation Status says Default, continue with this procedure.

8. Tap Compensate Probe to open the Probe Compensation dialog.

9. Tap Compensate Probe to run the probe compensation.

10. The probe compensation is finished when the Probe Compensation Status displays Pass. Disconnect the probe tip and
ground from the PROBE COMP terminals.
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11. Repeat these steps for each supported passive probe that you want to compensate for this channel.

12. Repeat these steps to compensate supported probes on other channels of the oscilloscope.

NOTE. For most accurate measurements, open the Probe Setup panel and verify the Probe Compensation Status is Pass
whenever you attach a probe to a channel.

Connect to a network (LAN)
Connecting to a network allows you to remotely access the instrument.

Work with your network administrator to obtain the required information to connect to your network (IP address, Gateway IP
address, Subnet Mask, DNS IP address, and so on).

1. Connect a CAT5 cable from the oscilloscope LAN connector to your network.

2. Select Utility > I/O on the menu bar to open the I/O configuration menu.

3. Obtain or enter the network address information:

■ If your network is DHCP-enabled, tap Auto to obtain the IP address information from the network. DHCP mode is the
default mode.

■ If your network is not DHCP-enabled, or you need a permanent (non-changing) IP address for this instrument; tap
Manual and enter the IP address and other values provided by your IT or system administrator resource.

4. Tap Test Connection to verify that the connections is working. The LAN Status icon turns green when the instrument
successfully connects to your network. If you have problems connecting to your network, contact your system administration
resource for help.
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Operating basics
These procedures are an introduction to using the interface to do common tasks. See the Help information in the application for
detailed information on menu and field settings.

Add a channel waveform to the display
Use this procedure to add a channel signal to the Waveform View.

1. Connect signal(s) to the channel input(s).
2. Tap an Inactive Channel button (in the Settings bar) of a connected channel.

 

 

The selected channel is added to the Waveform View and a Channel badge is added to the Settings bar.
 

 
3. Continue tapping Inactive Channel buttons to add more channels (digital or analog). Channels are displayed from lowest-

numbered channel at the top, to highest-numbered channel at the bottom of the view, regardless of the order they were
added (in stacked mode).
 

 
4. Double-tap a channel badge to open that channel's configuration menu to check or change settings. See Configure channel

or waveform settings on page 34.
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Configure channel or waveform settings
Use the channel and waveform configuration menus to set parameters such as vertical scale and offset, coupling, bandwidth,
probe settings, deskew values, external attenuation values, and other settings.

Prerequisite: There is a channel or waveform badge in the Settings bar.

1. Double-tap a Channel or Waveform badge to open a configuration menu for that item.

For example, in a Channel menu, use the Vertical Settings panel to set basic probe parameters such as vertical scale and
position, offset, coupling, termination, and bandwidth limit.
 

 

2. Tap the Probe Setup panel to confirm probe settings and run configuration or compensation on supported probes.
 

 

3. Tap the Other panel to set probe deskew, external attenuation, and alternate units parameters.
 

 

4. Tap the Help icon on the menu title to open the help topic for more information.

5. Tap outside the menu to close the menu.
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Quickly display a waveform (Autoset)
The Autoset function analyzes the signal characteristics and changes the instrument Horizontal, Vertical, and Trigger settings to
automatically display a triggered waveform. You can then make further changes to trigger and horizontal settings to view the
waveform point of interest.

1. Connect the probe with the signal of interest to the lowest-numbered channel. The signal can be analog or digital.

2. Connect any other associated signal(s) to available channel input(s).

3. Add the channel waveforms to the Waveform view. Add a channel waveform to the display on page 33

4. Push the front-panel Autoset button. When using the Stacked Display mode, the instrument analyzes the signal
characteristics of the lowest-numbered displayed channel (analog or digital) and adjusts the horizontal, vertical, and trigger
settings accordingly to display a triggered waveform for that channel. Vertical scale is adjusted for all other active
waveforms to maximize ADC utilization.
 

 
When using the Overlay Display mode, the instrument adjusts the horizontal and trigger settings of the lowest-numbered
displayed channel to display a triggered waveform for that channel, and adjusts the vertical settings and position of all active
waveforms such that they are uniformly spaced on screen.

Autoset guidelines:

■ Autoset displays two or three cycles (depending on the detected signal) with the trigger level near the midlevel of the signal.

■ The trigger is set to type Edge, rising slope, DC coupling.

■ If no channels are displayed before pushing Autoset, the oscilloscope adds Ch 1 to the view whether it has a signal or not.

■ For digital signals, the oscilloscope analyzes and triggers on the lowest (LSB) digital channel with an active signal.

■ Autoset ignores math, reference, and bus waveforms.

■ A channel or waveform with a frequency less than 40 Hz is classified as no signal.
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How to trigger on a signal
Use this procedure to open the Trigger menu to select and configure the trigger event type and conditions.

1. Double-tap the Trigger badge on the Settings bar to open the Trigger configuration menu.

2. Select a trigger from the Trigger Type list. The trigger type sets what fields are available in the menu and also updates the
illustration to show a graphic of the trigger type.
 

 

NOTE. To trigger on a bus, you must first add the bus to the Waveform view. See Add a math, reference, or bus waveform
on page 38

NOTE. Triggering on buses other than Parallel requires purchasing and installing serial trigger and analysis options. See the
Tektronix Web site for available serial trigger and analysis options.

3. Select the other fields and panels to refine the trigger conditions. The menu fields and trigger graphic update as you make
changes to the trigger settings. Displayed fields depend on the selected trigger type. Selection changes take effect
immediately.
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4. Tap the Help icon on the menu title for more information on these settings.

5. Tap outside the menu to close the menu.

Set the acquisition mode
Use this procedure to set the method the instrument uses to acquire and display the signal.

1. Double-tap the Acquisition badge on the Settings bar to open the Acquisition configuration menu.

2. Select the acquisition method from the Acquisition Mode list. Set any other parameters associated with the selected
acquisition type.
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3. Tap the Help icon on the menu title for more information on these settings.

4. Tap outside the menu to close the menu.

Set Horizontal parameters
Use this procedure to set the horizontal time base parameters such as mode, minimum sample rate, horizontal scale, delay, and
trigger delay time (relative to the center of the waveform record.

1. Double-tap the Horizontal badge on the Settings bar to open the Horizontal configuration menu.
 

 

2. Use the menu selections to set horizontal parameters.

3. Tap the Help icon on the menu title for more information on these settings.

Add a math, reference, or bus waveform
Math waveforms let you create new waveforms based on operations between two or more waveforms or by applying equations to
waveform data. A reference waveform is a static waveform record displayed for comparison. Bus waveforms let you view and
analyze serial or parallel data.

There is no set limit to the number of Math, Reference, or Bus waveforms you can add to the Waveform View, other than system
physical memory constraints.

1. Tap the Add New Math, Add New Ref, or Add New Bus button in the Settings bar.
 

 

2. The instrument adds the waveform to the Waveform view, adds a Waveform badge to the Settings bar, and opens a
configuration menu. This example shows adding a Math waveform.
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3. Use the configuration menus to refine the waveform parameters. Displayed fields depend on the waveform and selections
made in the menu. Selection changes take effect immediately.
This example shows adding a Math waveform, using the Math Source fields to select Ch 1 and Ch 2 as the waveform
sources, and set the math type to Basic math operation, and subtracting channel 2 from channel 1.
 

 

4. When adding a Reference waveform, the instrument presents a Recall configuration menu. Navigate to and select the
reference waveform file (*.wfm) to recall, then tap the Recall button. The instrument displays the Reference waveform and
opens the configuration menu.

5. Double-tap a math, reference, or bus badge to check or change that waveform's settings. See Configure channel or
waveform settings on page 34.

6. Tap the Help icon on a configuration menu title for more information on math, reference, and bus waveform settings.

7. Tap outside the menu to close the menu.
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Add a measurement
Use this procedure to select and add measurements.

1. Acquire the channel(s) and/or waveform(s) on which you want to take measurements.
 

 

NOTE. Waveforms do not need to be displayed to be used for measurements, as long as the channel or waveform badge is
on the Settings bar and is acquiring the signal to measure.

2. Tap the Add New...Measure button to open the Add Measurements configuration menu.
 

 

3. Tap the Source field and select the measurement source. All available sources that are valid for the measurement are
listed.
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4. Select from the configuration menu panels, such as Amplitude, Timing, and Jitter, to display measurements for those

categories.
5. Select a measurement and tap Add (or double-tap the measurement) to add the measurement to the Results bar. The

measurement badge is added immediately.
 

 
6. Select and add other measurements for the current source. Tap the measurement category panels to display and select

other measurements to add.
7. To add measurements for other sources, select a different source, select a measurement, and add the measurement.
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8. Tap outside the Add Measurements menu to close the menu.
9. To further adjust a measurement's settings, double-tap a measurement badge to open a configuration menu for that

measurement. See Configure a measurement on page 42.
10. Tap the Help icon on the menu title for more information on settings.

Configure a measurement
Use this procedure to add statistical readouts to the measurement badge, display plots for the measurement, and refine
measurement parameters (configuration, global versus local scope of settings, gating, filtering, and so on).

1. Double-tap a measurement badge to open its Measurement configuration menu.
 

 
2. Tap Show Statistics in Badge to add statistical readouts to the measurement badge.

 

 
3. Tap available panel titles to make changes for those categories.
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4. Use the available fields to refine the measurement conditions. Displayed fields depend on the measurement. Selection
changes take effect immediately. Selection changes can also change fields in other panels.

5. Tap the Help button on the menu title for more information on this menu's settings.

6. Tap outside the menu to close the menu.

Add a plot of a measurement
Measurement plots let you graph the distribution of waveform datapoint occurrences (histogram), plot the frequency components
(spectrum) of a waveform, show the time trend of a measurement, display an eye diagram, and other supported plots depending
on the measurement. Available plots depend on the measurement.

1. Double-tap a Measurement badge to open the Meas configuration menu.
 

 

2. Tap a Plots button to add that plot for the measurement to the screen.
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The following shows adding a Histogram plot.
 

 
You can add more than one plot to measurements (to different measurements or the same measurement). For example,
you can add two histogram plots for the same measurement, set one to display the X-Axis with a Logarithmic scale, and the
other plot to display the X-Axis with a Linear scale.

3. You can move plot windows by dragging the Plot view title bar to a new position. The blue background area moves to show
where the plot will be located when you remove your finger from the title bar. You can also resize plot windows by selecting
and dragging the Plot view border. You should use a mouse to do these operations, as it is easier to select and drag plots
with a mouse.
 

 

4. Double-tap within a Plot view to open a configuration menu to set display characteristics. Tap the Help icon on the
configuration menu title for more information on that menu's settings. Tap outside the menu to close the menu.
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Add a Search
Use this procedure to set search criteria and mark a waveform where those events occur.

You can search on analog and digital signals, math waveforms, and reference waveforms. You can add searches to different
waveforms and multiple searches to the same waveform. Prerequisite: Display the channel or waveform signal on which to
search. The waveform must be displayed to create a search for it.

1. Display the channel or waveform signal on which to search. The waveform must be displayed to create a search for it.

2. Tap the Add New...Search button to open the Search configuration menu.
 

 

3. Use the configuration menu fields to set the search criteria in the same way that you would set for a trigger condition (select
the Search Type, Source, and conditions on which to search).

NOTE. You cannot search for sequential events (there is no Sequence search type).

4. The searched waveform is marked with one or more triangles as soon as the search criteria becomes true. Each search
uses a different color for its markers. The example image shows search criteria set to find positive pulse widths that are less
than 70 ns wide.
 

 

5. To stop showing marks on a waveform, double-tap the Search badge and tap Display to Off.

6. To move the waveform to center marks on the display, push the Run/Stop front panel button to stop acquisition, single-tap
a Search badge, and tap the < or > Navigation button.
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NOTE. Navigation buttons are only functional when the oscilloscope acquisition mode is set to Stop.

This opens the Zoom mode and moves the waveform to the previous or next event mark on the waveform.

7. If available for a search, tap the Min or Max button to center the waveform in the display at the minimum or maximum value
of the search events in the waveform record.

8. To return the instrument to normal acquisition mode, tap the Zoom icon in the upper right corner of the Waveform View to
turn off Zoom mode, and push the Run/Stop front-panel button to set it to Run mode.

Delete a Measurement or Search badge
Use this procedure to remove a Measurement or Search badge from the Results bar.

1. Touch and hold the Measurement or Search badge that you want to delete. The instrument opens a right-click menu.

2. Select Delete Meas to delete that badge from the Results bar.
 

 

3. You can also delete a Measurement or Search badge by dragging it to the Trash Can icon, located at the bottom of the
Results bar. When the Trash can icon and the badge turns red, lift your finger to delete the badge. You can use the mouse
to drag and delete a badge.

NOTE. You can undo a measurement delete.
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Change waveform view settings
Use this procedure to change the waveform display mode (Stacked or Overlay), waveform trace interpolation algorithm,
waveform persistence, style and intensity, and graticule style and intensity.

1. Double-tap on an open graticule area to open the Waveform View configuration menu.
 

 

2. Tap the buttons in the Display Mode to toggle between Overlay and Stacked modes.
 

 

3. Use the other controls to set the waveform interpolation algorithm, waveform point persistence, style, and intensity, and
graticule style and intensity.

4. Tap the Help icon on the menu title to open the Waveform View menu help topic for more information on the waveform view
parameters.

5. Tap outside the menu to close the menu.

Display and configure cursors
Cursors are on-screen lines that you can move to take measurements on specific parts of a waveform or plot, or between two
different waveforms. Cursor readouts show both current position values and the difference (delta) between cursors.

1. Tap the waveform slice (in Stacked mode), or the channel or waveform badge (in Overlay mode) to which you want to add
cursors.

2. Tap the Add New...Cursors button, or push the front-panel Cursors button.

The cursors are added to the display.
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3. Use Multipurpose Knobs A and B to move the cursors, or touch and drag a cursor. Cursors show readouts that show
position and difference measurements between the cursors.

4. To move the cursors to a different channel or waveform, just tap in that waveform graticule.
 

 

5. To further configure cursors, double-tap on either cursor line or the cursor readouts to open the Cursors configuration
menu. For example, tap the Cursor type to select the cursors to display, such as Waveform, V Bars, H Bars, and V&H Bars.
 

 

6. To split the cursors between two waveforms, tap the Source field and select Split and select the source for each cursor.
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The cursors are moved to the specified waveforms.

7. Tap the Help icon on the menu title for more information on the menu settings.

8. To stop showing cursors, push the front panel Cursor button, press and hold to open the right-click menu and turn cursors
off, or open the Cursors configuration menu and set Display to Off.

Remote access from a Web browser
You can remotely control your oscilloscope from a browser. Enter the IP address into your Web browser to display the
oscilloscope screen and use a mouse to access all screen-based controls and items on the oscilloscope.

Prerequisites:

■ The IP address of the oscilloscope that you want to access. To determine an oscilloscope's IP address, select Utility > IO in
the oscilloscope menu bar and view the network settings in the LAN panel.

■ The oscilloscope must be connected to, and accessible from, the network to which the PC is connected. See Connect to a
network (LAN) on page 32

1. Open a Web browser on a PC connected to the same network as the oscilloscope.

2. Enter just the oscilloscope IP address on the URL line of the browser and press Enter. For example: 135.62.88.157.

The browser searches for and opens the Web page for the oscilloscope.

3. Select Instrument Control (e*Scope®).

The browser displays the instrument screen.

4. Use a mouse to select and interact with the oscilloscope controls shown in the Web browser.

 Operating basics
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Connect the oscilloscope to a PC using a USB cable
Use a USB cable to connect the oscilloscope directly to a PC for remote instrument control.

1. On the oscilloscope, select Utility > I/O from the menu bar.

2. Tap USB Device Port Settings.

3. Confirm that the USB Device Port control is On (default setting).

4. Connect a USB cable from the PC to the USB Device port on the rear of the instrument.

5. If using the USB connection to remotely control the oscilloscope using GPIB commands, set the GPIB Talk/Listen Address
for your configuration (0 - 30).
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Cleaning the instrument

Cleaning
Use a dry, soft cotton cloth to clean the outside of the unit. Do not use any liquid cleaning agents or chemicals that could damage
the touch screen, case, controls, screen, markings or labels, or possibly infiltrate the case.
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EMC, safety and environmental compliance

Compliance Information
This section lists the EMC (electromagnetic compliance), safety, and environmental standards with which the instrument
complies.

EMC compliance

EU EMC directive
Meets intent of Directive 2014/30/EU for Electromagnetic Compatibility. Compliance was demonstrated to the following
specifications as listed in the Official Journal of the European Communities:

EN 61326-1, EN 61326-2-1. EMC requirements for electrical equipment for measurement, control, and laboratory use.  1 2 3 4

■ CISPR 11; IEC 61000-4-2; IEC 61000-4-3   5; IEC 61000-4-4; IEC 61000-4-5; IEC 61000-4-65; IEC 61000-4-11 

EN 61000-3-2. AC power line harmonic emissions

EN 61000-3-3. Voltage changes, fluctuations, and flicker

European contact.
Tektronix, Inc. PO Box 500, MS 19‐045
Beaverton, OR 97077, USA
www.tek.com

Australia / New Zealand EMC
Complies with the EMC provision of the Radiocommunications Act per the following standard, in accordance with ACMA:

■ EN 61326-1 and EN 61326-2-1. Radiated and Conducted Emissions, Group 1, Class A

1 This product is intended for use in nonresidential areas only. Use in residential areas may cause electromagnetic interference.
2 Emissions which exceed the levels required by this standard may occur when this equipment is connected to a test object.
3 Equipment may not meet the immunity requirements of applicable listed standards when test leads and/or test probes are connected due to coupling of electromagnetic

interference onto those leads/probes. To minimize the influence of electromagnetic interference, minimize the loop area between the unshielded portions of signal and
associated return leads, and keep leads as far away as possible from electromagnetic disturbance sources. Twisting unshielded test leads together is an effective way to
reduce loop area. For probes, keep the ground return lead as short as possible and close to the probe body. Some probes have accessory probe tip adapters to
accomplish this most effectively. In all cases, observe all safety instructions for the probes or leads used.

4 For compliance with the EMC standards listed here, high quality shielded interface cables should be used.
5 ±≤ 1.0 division waveform displacement or ≤ 2.0 division increase in peak-to-peak noise is allowed when the instrument is subjected to fields and signals as defined in

the IEC 61000-4-3 and IEC 61000-4-6 tests.
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Safety compliance
This section lists the safety standards with which the product complies and other safety compliance information.

EU low voltage directive
Compliance was demonstrated to the following specification as listed in the Official Journal of the European Union:

Low Voltage Directive 2014/35/EU.

■ EN 61010-1;  EN 61010-2-030 

U.S. nationally recognized testing laboratory listing
■ UL 61010-1;  UL 61010-2-030 

Canadian certification
■ CAN/CSA-C22.2 No. 61010-1;  61010-2-030 

Additional compliances
■ IEC 61010-1;  IEC 61010-2-030 

Equipment type
Test and measuring equipment.

Safety class
Class 1 – grounded product.

Pollution degree rating
Pollution Degree 2 (as defined in IEC 61010-1). Rated for indoor, dry location use only.

Measurement and overvoltage category description
Measurement terminals on this product may be rated for measuring mains voltages from the following category (see specific
ratings marked on the product and in the manual).

■ Category II. Circuits directly connected to the building wiring at utilization points (socket outlets and similar points).

NOTE. Only mains power supply circuits have an overvoltage category rating. Only measurement circuits have a measurement
category rating. Other circuits within the product do not have either rating.

Mains overvoltage category rating
The mains power supply circuit for this product is rated for overvoltage category II (as defined in IEC 61010-1).
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Environmental compliance
This section provides information about the environmental impact of the product.

Product end-of-life handling
Observe the following guidelines when recycling an instrument or component:

Equipment recycling. Production of this equipment required the extraction and use of natural resources. The equipment may
contain substances that could be harmful to the environment or human health if improperly handled at the product’s end of life.
To avoid release of such substances into the environment and to reduce the use of natural resources, we encourage you to
recycle this product in an appropriate system that will ensure that most of the materials are reused or recycled appropriately.

This symbol indicates that this product complies with the applicable European Union requirements according to
Directives 2012/19/EU and 2006/66/EC on waste electrical and electronic equipment (WEEE) and batteries. For
information about recycling options, check the Tektronix Web site (www.tek.com/productrecycling).

Perchlorate materials. This product contains one or more type CR lithium batteries. According to the state of California, CR
lithium batteries are classified as perchlorate materials and require special handling. See www.dtsc.ca.gov/hazardouswaste/
perchlorate for additional information.
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Index
A
A knob, 7
Acquisition controls, 7
acquisition menu, open, 37
add a channel to the display, 33
add a measurement badge, 40
add a measurement plot, 43
add a search badge, 45
Add New

Bus waveform button, 16
Math waveform button, 16
Ref waveform button, 16

add waveform to screen, 33
AFG option, 16
AFG Out (rear panel), 14
automatic probe compensation (TPP0500, TPP1000), 30
Autoset, 35
Autoset button, 7
AUX Out (rear panel), 14
avoid pinching when rotate handle, 1

B
B knob, 7
badge types, 19–24
badges, 19–24
Bus button, 7
bus waveforms, 38

C
cable lock, 14
change display settings, 47
change measurement settings, 42
channel badge, 19–24
Channel buttons (front panel), 7
channel menu, 34
channel settings, 34
channel vertical parameters menu, 34
Clear button, 7
clipping message, 19–24
clock format (12/24 hr), how to set, 29

common touchscreen UI tasks, 27
compensate TPP0500, TPP1000 probes, 30
Compliance information, 53
configuration menus, 24
configure a measurement, 42
connect lock cable, 3
connect to a network, 32
connecting probes, 5
correct handle rotate, 1
Cursors button, 7
Cursors button (touchscreen), 15
cursors menu, 47

D
Date/Time badge, turn display on, off, 29
Default Setup button, 7
delete a measurement badge, 46
display a channel, 33
display cursors, 47
Display Port video output (rear panel), 14
Draw-a-Box button, 15
Draw-a-Box button (Zoom), 26
DVI video output (rear panel), 14
DVM option, 16

E
e*Scope, 49
EMC compliance, 53
Environment requirements, 2
Ethernet port (rear panel), 14
Ethernet, connect to, 32
EU EMC directive, 53
expansion point, waveform, 16

F
Fast Acq button, 7
firmware, how to update, 29
FlexChannel connectors (front panel), 7
Force button, 7
front cover, 1
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front panel
Acquisition, 7
Autoset button, 7
Bus button (front panel), 7
Channel buttons (front panel), 7
Clear button, 7
Cursors button, 7
Default Setup, 7
description, 7
Fast Acq button, 7
FlexChannel connectors, 7
Force button, 7
High Res button, 7
Horizontal, 7
Level knob, 7
Math button (front panel), 7
Miscellaneous, 7
Mode button, 7
multipurpose knobs, 7
Navigate buttons (front panel), 7
Position knob, 7
Position knob (horizontal), 7
probe compensation connectors, 7
Ref button (front panel), 7
Run/Stop button, 7
Scale knob, 7
Scale knob (horizontal), 7
Single/Seq button, 7
Slope button, 7
Touch Off button, 7
Trigger, 7
USB ports, 7
Vertical, 7
Zoom button (front panel), 7
Zoom/Pan knobs (horizontal), 7

G
GPIB talk/listen address, 50
graticule intensity, 47
graticule style, 47

H
handle rotate, 1

handles, analog and digital, 16
High Res button, 7
Horizontal controls, 7
horizontal menu, open, 38
how to

connect probes, 5
add a measurement, 40
add a measurement plot, 43
Add bus waveform, 38
Add math waveform, 38
Add reference waveform, 38
add waveform to screen, 33
change display settings, 47
change graticule intensity, 47
change graticule style, 47
change measurement settings, 42
change persistence, 47
change waveform intensity, 47
change waveform interpolation, 47
check power-on self tests results, 5
compensate TPP0500, TPP1000 probes, 30
connect probes, 5
connect to network, 32
connect to PC using USB cable, 50
delete a measurement, 46
display cursors, 47
download, install firmware, 29
open acquisition menu, 37
open horizontal menu, 38
quickly display waveform (Autoset), 35
remote access the oscilloscope (from Web), 49
run signal path compensation (SPC), 30
set acquisition parameters, 37
set channel vertical parameters, 34
set clock format (12/24 hr), 29
set Date/Time badge on, off, 29
set GPIB talk/listen address, 50
set horizontal parameters, 38
set probe deskew, 34
set probe parameters, 34
set time zone, 29
set trigger parameters, 36
update firmware, 29
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use Autoset, 35
use mouse with the UI, 27

How to
change display mode (stacked, Overlay), 47

I
inactive channel buttons, 16
input signal level requirements, 3
intensity, graticule, 47
intensity, waveform, 47

K
knob A, 7
knob B, 7

L
LAN port (rear panel), 14
LAN, connect to, 32
Level knob, 7
lock to bench or rack, 3
LXI, 49

M
marking waveform events, 45
Math button, 7
math waveforms, 38
Measure button, 15
measurement

plots, 43
measurement badge, 19–24
measurement badge, delete, 46
Menu bar, 15
menu panels, 24
menus, 24
Miscellaneous controls, 7
Mode button (front panel), 7
mouse touchscreen UI equivalents, 27
move cursors, 47
multipurpose knobs, 7

N
Navigate buttons (horizontal), 7

navigation buttons, badges, 19–24
network, connect to, 32
Note button, 15

O
open acquisition menu, 37
open horizontal menu, 38
operating

altitude range, 2
humidity range, 2
temperature range, 2

operating power requirements, 2
overlay mode (waveforms), 47

P
Pan, 26
panels, menu, 24
persistence, waveform, 47
pinching and handle rotate, 1
plot a measurement, 43
Plot button, 15
Position knob, 7
Position knob (horizontal), 7
power cord connector (rear panel), 14
power cord wrap, 4
power requirements, 2
power standby mode, 4
power-on test results, 5
powering on or off, 4
probe compensation (TPP0500, TPP1000), 30
probe compensation connectors, 7
probe deskew, set, 34
probe inputs, 7
probe parameters, set, 34
probes

connecting, 5
probes, connecting, 5
proper handle rotate, 1

R
rack mount kit information, 6
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rear panel
AFG Out, 14
AUX Out, 14
cable lock, 14
Display Port video output, 14
DVI video output, 14
Ethernet port (RJ-45), 14
LAN port (RJ-45), 14
power cord, 14
security cable lock, 14
USB Device port, 14
USB Host ports, 14
VGA video output, 14
video outputs, 14

rear panel connections, 14
record view, waveform, 16
Ref button, 7
Ref In, 14
Ref In (rear panel), 14
reference waveforms, 38
remote access (e*Scope), 49
remote access (Web-based), 49
remove AC power from instrument, 4
requirements

altitude, 2
environment, 2
humidity, 2
power, 2
signal inputs, 3
temperature, 2

Results bar, 15
Results Table button, 15
RM5 rack mount, 6
run signal path compensation, 30
Run/Stop button, 7

S
Safety compliance, 53
scale buttons, badge, 19–24
Scale knob, 7
Scale knob (horizontal), 7
search badge, 19–24
Search button, 15
searching for events, 45

security cable lock, 14
set

clock format (12/24 hr), 29
Date/Time badge display on, off, 29
GPIB talk/listen address, 50
probe deskew, 34
probe parameters, 34
time zone, 29

Settings bar, 15
shipped probes, 1
show a measurement, 40
signal input levels, 3
Single/Seq button, 7
Slope button (front panel), 7
SPC (signal path compensation), 30
stacked mode (waveforms), 47
standard accessories, 1
storage pouch, 1

T
TekVPI, 5
TekVPI input connectors, 7
time zone, how to set, 29
Touch Off button, 7
touchscreen UI tasks, 27
Trash Can icon, 15
trigger

level indicators, 16
position indicator, 16

Trigger controls, 7
trigger menu, 36
trigger the oscilloscope, 36
turn instrument on or off, 4

U
USB cable, connect to PC, 50
USB Device port (rear panel), 14
USB Host ports (rear panel), 14
USB ports (front panel), 7
use cursors, 47
User button, 7
using mouse with the touchscreen, 27
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V
Vertical controls, 7
VGA video output (rear panel), 14
video outputs (rear panel), 14

W
waveform

expansion point, 16
intensity, 47
persistence, 47
record view, 16

waveform badge, 19–24
Waveform View, 15

Z
Zoom box, 26
Zoom button (front panel), 7
zoom icon, 16
Zoom overview, 26
Zoom title bar, 26
Zoom/Pan knobs (horizontal), 7
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